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1 Notes on the Operating Manual  
 
 

This operating manual is a technical guide on how to operate the device safely and 
it contains all the information required for the areas specified in the table of 
contents. This technical documentation is a reference and instruction manual. The 
individual chapters are complete in themselves. 
Familiarity (of the respective target groups defined according to area) with the 
relevant chapters is a precondition for the safe and appropriate use of the device. 
This operating manual does not contain any repair instructions. If faults arise or 
repairs are necessary, please contact your supplier or get in touch with Endecotts 
directly. 
Application technology information relating to samples to be processed is not 
included but can be read on the Internet on the respective device’s page at 
(www.endecotts.com) 
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1.1 Explanations of the safety warnings  
 
 

In this Operating Manual we give you the following safety warnings  
 
Serious injury  may result from failing to heed these safety warnings. We give you 
the following warnings and corresponding content.     
 

 WARNING  

Type of danger / personal injury 
Source of danger 
– Possible consequences if the dangers are not observed. 
• Instructions on how the dangers are to be avoided. 

 

We also use the following signal word box in the text or in the instructions on action 
to be taken: 

 WARNING 
 
Moderate or mild injury  may result from failing to heed these safety warnings. 
We give you the following warnings and corresponding content.  
 

 CAUTION  

Type of danger / personal injury 
Source of danger 
– Possible consequences if the dangers are not observed. 
• Instructions on how the dangers are to be avoided. 

 

We also use the following signal word box in the text or in the instructions on action 
to be taken: 

 CAUTION 
 
In the event of possible property damage we inform you with the word 
“Instructions” and the corresponding content. 
 

NOTICE 

Nature of the property damage 
Source of property damage 
– Possible consequences if the instructions are not observed. 
• Instructions on how the dangers are to be avoided. 

 

We also use the following signal word in the text or in the instructions on action to 
be taken: 
NOTICE 
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Bestätigung  

2 Confirmation (Form for the operator)  
 

This operating manual contains fundamental instructions and it is imperative that 
they be heeded when using this software. It is essential that they be read by the 
operator and by the qualified staff responsible for the software before the software 
is used. This operating manual must be available and accessible at the place of 
use at all times. 
The user of this software herewith confirms to the managing operator / owner that 
(s)he has been given sufficient instructions about the use of the software. The user 
has received the operating manual, has read and taken note of its contents and 
consequently has all the information required for safe use and is sufficiently familiar 
with the software. 
As the owner/managing operator you should for your own protection have your 
employees confirm that they have received instructions on how to use the 
software. 

 

 I have read and taken note of the contents of all chapters in this operating 
manual as well as all safety instructions and warnings. 

 

 User  

   

 Surname, first name (block letters)  

   

 Position in the company  

   

 Signature  

   

 Service technician or operator  

   

 Surname, first name (block letters)  

   

 Position in the company  

   

 Place, date and signature  
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3 Installation  
 • 

This operating manual is a technical guide on how to operate the device safely and 
it contains all the information required for the areas specified in the table of 
contents. This technical documentation is a reference and instruction manual. The 
individual chapters are complete in themselves. 
Familiarity (of the respective target groups defined according to area) with the 
relevant chapters is a precondition for the safe and appropriate use of the device. 
This operating manual does not contain any repair instructions. If faults arise or 
repairs are necessary, please contact your supplier or get in touch with Endecotts 
directly. 
Application technology information relating to samples to be processed is not 
included but can be read on the Internet on the respective device’s page at 
(www.endecotts.com) 

3.1 Installation  
 

Please start SieveWare_setup.exe from the installation CD-ROM. Then follow the 
user prompting. 
During installation the SIEVESYS and SIEVEDAT directories are created in the 
directory: 
C:\Documents and Settings\All users\Application Data\SieveWare  
SIEVESYS has the ENDECOTTS.afg (standard sieving task) and 
ENDECOTTS.gkl ( standard sieve stack) files. In SIEVEDAT has an Endecotts 
subdirectory with the Endecotts001.rdf and Endecotts002.rdf sievingfiles.  
As soon as these files are there, all SieveWare menu items can be selected. 
All files required for Help and the SieveWareDocumentation_en.pdf manual are 
installed in the program directory also. 

 

4 General Notes  
 

This software serves to support sievings and the storage and representation of 
particle size distributions determined with the sieve analysis. For each sieving the 
measurements are stored in a file (rdf file) and are then available for extensive 
evaluation. 
SieveWare permits the use of 16 sieves + sieve base. The largest supported sieve 
mesh aperture size  is 125 mm.  

 

4.1 Working procedure  
 

The use of SieveWare for sieve analysis requires three steps, which are separate 
from each other: 
  1. Definition of a sieving task   
  2. Execution of the sieving 
  3. Evaluation of the results 
Automatic weight transfer is also possible from a balance equipped with a serial 
data interface. SieveWare can accept manually input data too of course. 
The evaluation can be conducted at a separate time from the measurement, i.e. 
the raw data can be inputted again later and evaluated. The raw data contains the 
name of the associated sieving task. This is loaded when a raw data file is read if 
another sieving task was active beforehand. Consequently the raw data is always 
evaluated with the parameters that were set in the sieving task at the time of the 
evaluation. This makes it possible to evaluate measurements at a later point in 
time with altered parameters. 
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To prevent an accidental alteration of the parameters in a sieving task, password 
protection can be activated in SieveWare with two user levels:  
 1. Measuring mode:  

• Measurements and evaluation are possible.  The measuring mode  
is particularly suitable for routine operation.   

2. Task mode:  
• In addition to the measuring mode, it is also possible to create and 

alter sieving tasks. SieveWare is always in task mode if the 
password protection has not been activated. 
The task mode is intended for qualified users with a very good 
knowledge of the program. 

Note: The following describes all the menus active in the task mode. Some of the 
menus described are inactive in the measuring mode and accordingly not visible. 
The files in which the sieving tasks are defined are filed in the sub-
directory...\SIEVESYS . The measuring results are filed as consecutive files in the 
sub-directory… \ SIEVEDAT \ <Name of sub-directory>. The sub-directory is 
defined in the sieving task. An increment postfix will be created automatically by 
the software in order to prevent existing sieving files being overwritten. 
Example: 
  Directory: Sand 
  File name:   Test 
  File no.:   6 
The sieving result is stored in the following raw data file.  
...\SIEVEDAT\Sand\Test006.rdf  
The creation of the following files is optional. 
 ...\SIEVEDAT\Sand\Test006.ccg  
 ...\SIEVEDAT\Sand\Test006.xle  

 

4.2 File System  
 

The program directory  software  selected during installation has the sieveware.exe 
and sieveware.hlp software.  The …\SIEVESYS and ….\SIEVEDAT sub-directories  
are stored in the program directory too. 
In the SIEVESYS sub-directory the program stores the following files: 
task files    *.afg  (internal format) 
sieve stack files  *.gkl  (internal format) 
reference files    *.ref  (ASCII format) 
 
Files in ASCII format (*.ref) can be presented as reference curves at the same time 
as the sieve curves in the diagram and serve to generate the adjustment files. 
In the SIEVEDAT sub-directory further sub-directories are created, whose names 
are decided in the individual sieving tasks. The following sieving files are stored in 
these sub-directories: 
 
•  *.rdf   Raw data files (raw data in the internal format) 
•  *.xle  EXCEL decimal point, English (measurements table - EXCEL D 

  decimal point English, configurable, optional) 
•   *.ccg  ENDECOTTS file format (ASCII format, optional) 
After installation ENDECOTTS.afg  (first sieving task) and ENDECOTTS.gkl ( sieve 
stack file for the standard sieve stack) are in \SIEVESYS. SIEVEDAT has a 
\ENDECOTTS sub-directory with a ENDECOTTS_001.rdf sieving. 
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4.3 Creation of a sieving task  
 

A sieving task file contains all the SieveWare program settings required for the 
sieving and to show the results of a particular type of material. These settings are 
stored in the *.afg task file. This task file contains: 
All sieving parameters 
− the log texts defined for the task 
− directory, file name and file number for the result files 
− The name of the associated sieve stack file in which the limits desired for the 

evaluation are stored. 
− information on which result files are to be created 
− the density [g/cm³] of the material 
− settings in the measurement table 
− settings in the measurement diagram 
− settings for calculating characteristics 
− settings for the trend analysis 
At the point of time of the commencement of a sieving there must be at least one 
sieving task file and the associated sieve stack file. 
An existing sieving task can be edited in the “Sieving Analysis”– “Edit sieving task” 
menu item. Then all the windows in which the essential parameters for 
measurement and presentation can be set are opened one after another (“Next” 
key). The sieving task is stored at the end of the procedure. 
The “Sieving” – “New Sieving Task” menu item is used to produce a new sieving 
task quickly. Initialisations can be set quickly by input a “file name” and all settings 
in the sieving task can be determined quickly with a “minimum run”. 
Alternatively the menu items can be called up separately: 
• “Options” - “sieving parameters”  
 definition of the sieving parameters and characteristics  
• “Options” - “Edit sieve stack file” 
 definition of the sieves and storage in a sieve stack file  
• “Evaluation” - “table” 
 setting of the type of tabular presentation of the sieving result 
• “Evaluation” - “graph” 
 setting of the type of representation of the sieving result as a graph 
 choice of the axes, characteristics, colours, legend etc.  
• “Sieve analysis” - “save sieving task” 
•  Input of comment, name of the sub-directory, name of the results file, 

 number of the results file 
• Input of the material density 
• Storage of the sieving task 
In addition, the trend analysis settings are transferred into the sieving task. 
A sieve stack file is created by left-clicking on the “Save” button in the “Edit sieve 
stack file” menu item and entering a file name. 
A sieving task is created by calling up the “Sieve analysis” - “Save sieving task” 
menu item.  There must already be a sieve stack. 
The desired sieving parameters and display parameters must be set under the 
“Options” - “Sieving Parameters” menu item. The parameters for the evaluation 
must be selected in the “Evaluation” - “Table” and ”Evaluation" - “Graph” menu 
items. 
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4.4 Evaluating Measuring Results  
The measuring results can be evaluated  as a graph or table. Characteristics, 
which are typical of the whole measurement are presented in a separate window. 
The corresponding menu items  are “Evaluation” “Table…”, “Evaluation” - “Graph” 
and “Evaluation” - “Characteristics…”. The diagram can show several curves ( 
(maximum of 10). 
A trend analysis  is conducted to compare several measurements in a series of 
measurements. It allows the time-dependent behaviour  of some characteristics to 
be examined. The “Evaluation” “Mean” menu item allows the mean value of the 
sieving results  of a maximum 50 measurements belonging to a sieving task to be 
calculated and presented. 
All evaluation data can be printed and also copied into the clipboard. When the 
“File” - “Print Report…” menu item is called up, a log of the sieving measurements 
is printed out.  

4.5 Characteristics  
 

The following characteristics of particle size distributions can be determined with 
SieveWare: 
p3 (x1, x2)    Fractions p3 (x1, x2) (volume fractions in the individual sieve 
   classes) 
Q3 (x)   Cumulative distribution of Q3 (x), volume-related  
1-Q3 (x)   Cumulative residue distribution of 1-Q3 (x), volume-related 
q3 (x)   Distribution density q3 (x), volume-related  
 
The following characteristics can be determined with SieveWare: 
x (Q3)   x, where Q3 has a given value  
Span    Span value 
U    Unevenness, volume-related  
The characteristics are explained in more detail in the characteristics section.  

4.6 Password Protection  
 

When password protection is activated , the program controlled by the input of a 
password can be used in measuring mode or in task mode as desired.  
In the SieveWare software the measuring mode is intended for the execution of 
measurements and for routine evaluations with preset parameters. In the task 
mode it is also possible to change all sieving task parameters. 
When password protection is activated, SieveWare is in the measuring mode after 
start. The task mode is enabled once a password is inputted. The password 
protection can be deactivated by the user in the task mode. The program is always 
in task mode then. 
 
The following menu items in the main window are in the task mode in addition: 
“Options”  “Sieving parameters” 
“Options”  “Edit sieve stack file” 
“Sieve analysis” “Save sieving task” 
“Extras”  “Screen font” 
“Extras”  “Printer font” 
“Extras”  “Set printer log” 
The “Sieve analysis” dialogue box is different. Under the “Sieve analysis” – “load 
sieving task” menu item the loaded sieving tasks cannot be edited in the measuring 
mode. It is not possible either to change the characteristics setting for the trend 
analysis. 



General Notes  

14 

All the following descriptions of how the software functions refer to the menus in 
the task mode. 

4.7 Toolbar and Function Keys  
 

 
 

Fig. 1: Toolbar  
Frequently used functions in the SieveWare software can be activated very quickly 
by clicking on the buttons in the toolbar  in the main window or by means of the 
function keys. 
The following table shows a summary of the toolbar buttons. They are numbered 
from left to right. If the button corresponds to a menu item, the menu item is named 
beside it. Otherwise the function of the button is described in brief.  

No. of the button Menu item or function 

1 “File” - “Open results file” 

2 “File” - “Print Report” 

3 “Start sieving” 

4 New sieving 

5 Results table 

6 Results graph 

7 Characteristics 

8 Help command 

 
The following functions are accessible with the function keys: 

Function key Menu item or function 

F1 Help command 

F2 “Start sieving” 

F5 “Evaluation” - “Table” 

F6 “Evaluation” - “Graph” 

F7 “Evaluation” - “Characteristics” 

 

4.8 Conducting the First Sieving  
 

Once SieveWare is installed, the first sieving file can be transferred very easily. If 
the standard Endecotts sieve stack (45-µm, 63-µm, 125-µm, 250-µm, 500-µm, 1-
mm, 2-mm, 4-mm sieves) is to be used and the sieving machine and balance are 

1 2 3 4 5 6 7 8 
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not automatically controlled, the “Sieve Analysis “- “Start Sieve Analysis” menu 
item can be called up immediately. 
Otherwise the “Sieve Analysis” – “New Sieving Task” menu item should be called 
up. With prompting the settings are gradually made for: 
– sieving parameters (including setting-up of sieving machine and balance) 
– editing of sieve stack file (selection of the sieves to be used) 
–  saving of sieving task (setting of results files and report texts, storage of the 

 .afg file containing all settings*) 
The first sieving can be run through with SieveWare if so desired. 

5 Main Window - Description of the Menu Items  
5.1 File - Menu Commands  
 

The File menu contains the following commands: 
•   Open results file… 
•   Save results file as… 
•   Export results file… 
• Set up printer… 
•   Preview report 
•   Print report… 
• List of a selection of the last files  
• Exit 

    
Fig. 1: File Menu   

5.1.1 Open Results File  
 

Use this command to open a stored sieving. 
First an “Open” dialogue field appears allowing the file to be selected. 
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Fig. 2: “Open” to select a file  
Once a raw data file is selected and the window is exited by clicking on “OK”, the 
selected file is read. In each raw data file the name of the associated sieving task 
is stored. This sieving task is loaded (if not already active). The results are 
evaluated and presented by means of the now valid setting of the sieving task.   
NOTE  
If the sieving task was changed after the measurement, the results presented can 
differ from those in an evaluation conducted directly after the measurement! 
If one of the evaluation windows is open already, its contents will be updated. If no 
evaluation window is open, the diagram window is opened and the sieving result 
for the read file is presented as a graph. 
You can create new sievings (rdf files) by means of the “Sieve analysis” menu item.  

5.1.2 Save Results File as 
 

Use this command to save and rename the active sieving. SieveWare displays the 
“Save As” dialogue field so that you can assign a name to the rdf file you are 
generating. 

 
Fig. 3: Save as  
The save command is used to store a sieving under its existing name and 
directory. 
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5.1.3 Exporting Results File  
 

Use this command to save the active sieving in a file format that Excel can read. 
SieveWare displays the “Save as” dialogue field so that you can assign a name to 
the Excel or ASCII file which is to be produced. 

 
Fig. 4: Export Results File  
Possible file formats are: 
XLE Excel decimal point (English setting) 
CCG ENDECOTTS format 
The XLD and XLE files are structured analogously. The columns and units of 
measurement are chosen in the table window. All results selected there are 
entered into the file as a column. A maximum of 6 representations are possible (p3, 
Q3, 1-Q3, q3, ∆m, ΣΔm). The first two columns contain the lower and upper limits 
for the fraction. The values Q3 (x), 1-Q3 (x), refer to the upper class limit. On the 
other hand the q3 value refers to the middle of the faction and p3 to the fraction. 
In the XLD files decimal numbers are presented with a “comma”, while in the XLE 
files they are presented with a “point”.   
The CCG file consists of two columns. The first column is the particle size x in mm 
and the second column is the Q3 (x) - value (between 0 and 1). Decimal numbers 
are shown with a comma.  

5.1.4 Printer Set-up  
 

Use this command to choose a printer and decide on a printer connection. When 
this command is selected, the printer set-up window appears and you can choose 
the printer and its port in this window. 
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Fig. 5: Printer set-up  

 

5.1.5 Print Preview  

Use this command to display the sieving report as it would appear when printed. 
When this command is selected, the main window is replaced by a print preview 
window showing one or two pages in print format. 
In the symbol bar on the print preview you can decide if you wish to view one or 
two pages at the same time. You can also move forwards and backwards in the 
document, have pages shown in a larger or smaller size or start printing. 

5.1.6 Print Report  

Use this command to print a log of the sieving procedure. The printed sieving log 
consists of  
-   header information  
- table 
- graph 
-   characteristics 
The table, graph and characteristics settings are determined by the setting in the 
corresponding screen window in the sieving task. 
The header information is pre-set in the sieving task and can be updated by the 
user at the beginning of every sieving. 
When this command is selected, the print dialogue field appears and this is where 
you can enter the range of pages to be printed (if the report extends over several 
pages), the number of copies, the destination printer and other options for printer 
set-up. 

5.1.7 Selection List of the Last Files  

 One of the last 4 sievings can be loaded here.  

5.1.8 Exit  
 

Once all sieving parameters have been set, you can start the sieving if you wish. 
Use this command to end your SieveWare session. Alternatively, you can select 
the Close command from the application’s system menu.  
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5.2 Edit - Menu Commands  
 

The Edit menu contains the following commands: 
• Copy (result) table ASCII 
• Copy print report 
• Copy graph 
• Copy characteristics 
• Copy characteristics (ASCII) 

   
Fig. 1: Edit - Menu Commands  

5.2.1 Copy (Sieving Result) ASCII Table  
 

The values of x and Q3(x) are copied in text format into the clipboard in 
accordance with the sieve stack file set in the sieving task. The first line is the 
heading. The structure corresponds to the file in the Endecotts file format: x is in 
mm and Q3(x) is entered between 0 and 1. 

5.2.2 Copy Report  
 

The report is copied in Metafile format into the clipboard. It can then be pasted into 
other programs, e.g. into reports. 
If the report is printed out then from other programs, which involves indirect printing 
via the clipboard, differences may arise compared to reports printed out directly 
from SieveWare. Such differences relate in particular to font size, line thickness 
and line forms. 

5.2.3 Copy graph  

Copies the sieving results graph into the clipboard. 

5.2.4 Copy characteristics 

The preselected characteristics are copied in Metafile format into the clipboard. 
The file name of the sieving is pasted for the purposes of identifying the sieving. 
Mean values are marked as such. 

5.2.5 Copy characteristics (ASCII) 

The preselected characteristics are copied as ASCII text into the clipboard. All the 
report’s header data are exported as well. 

5.3 Sieving - Menu Commands  
 

The Sieve analysis menu contains the following commands: 
New sieve task   Creates a new sieve task 
Edit sieve task   Edits a predefined sieve task. 
Load sieve task   Loads a predefined sieve task. 
Save sieve task  Saves the last changes 
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Fig.1: Sieve Analysis Menu   

 

5.3.1 Start Sieve Analysis  
 

This command serves to conduct sieving with the aid of the parameters already set 
in the sieving task. 
Once the “Start sieve analysis” menu item has been selected, the “Start sieve 
analysis” dialogue box appears.   
This menu can also be started by simply pressing the F2 key. 

 
Fig.2: Start sieve analysis  
The setting options correspond to those described in Sieve Analysis – Sieving 
Task. First the settings saved in the sieving task (comments etc.) for report 
purposes and result storage are suggested. These should now be updated by the 
user as required to suit the sample to be analysed. 
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Likewise another sieve task or sieve stack file can be selected. If necessary, the 
sieving parameters can be changed or the sieve stack file edited. 
When the “Start” button is actuated, the window changes to the “sieving” window. 

 
Fig. 3: “Sieving“ Window  
All fields are greyed out in the measuring mode because no manual changes may 
be permitted here. The active field here is marked with three asterisks. In this 
window the weight (only) is entered by data transfer from the balance. 
Input of the tare weights: 
If a sieving was conducted already for the selected sieve stack file, the fields are 
filled with the last tare weights. The user has the option of accepting these now. In 
that case the cursor must simply be positioned at the ““total weight” input field. If 
you wish to update the tare weights, these are entered or transferred, beginning 
with “bottom”, whereby the cursor advances automatically to the next field.  
Input of the sieve load:  
The total weight of the sample must be transferred / entered into this field. Once 
the sieve load has been inputted, it is no longer possible to change the tare 
weights. The prompt for starting sieving comes then. 
Conducting the sieving:  
Once the sieve load has been inputted, the program prompts the execution of the 
sieving process. It can also be started by pressing the Sieve key. A precondition for 
this is that the tare weights and the sieve load are inputted completely depending 
on the selected sieving machine.   
Input of the sieve weights after finishing sieving: 
Now one after another, from coarse to fine, the sieving back weights must be 
transferred or entered with the sample material remaining on the sieves. If the 
value transferred is lighter than the corresponding tare weight, a fault alarm is 
given.  
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5.3.2 New sieve task  
 

Use this command for the quick generation of a new sieving task. All setting 
windows required to configure the sieving task are run through. No pre-
initialisations by other sieving tasks are used. 
By inputting a “file name”, you can quickly pre-initialise the name of the sieving 
task, the sieve stack file, the file directory for the sieving task and the names of the 
individual sieving files. 
Once all sieving parameters have been set, you can start the sieving if you wish. 

 

5.3.3 Edit Sieve Task  
 

The currently loaded and most recently executed sieving task is opened for editing. 
All setting windows required for editing the sieving task are run through (“Next” 
key). 

 

5.3.4 Loading the Sieving Task  
 

From a list of all previously set up sieving tasks a set of parameters can be loaded 
for the sieving to be conducted. After confirmation by pressing the “start …” key, 
the “start sieve analysis” window appears in which the header data of relevance to 
the following sieving can be edited. When the “Edit …” key is actuated, the “Sieving 
Parameters” window opens and the pending sieve analysis can be edited in this 
window. 

  
Fig.1: Load sieve task  

 
 

If alterations were made to a current sieving task and not yet saved, they can be 
saved now by means of the “Save Sieving Task” menu item, whereby some 
additional parameters can be set. The dialogue box that appears presents a 
summary of the essential settings for the sieving task. 
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 Fig.2: Save Sieving Task  

5.4 Evaluation – Menu Commands  
 

The evaluation menu contains the following commands: 
Table    Evaluation of sieving in tabular form 
Graph    Evaluation of sieving in the form of a graph 
Characteristics   Display of the sieving characteristics 
Mean value   Formation of a mean value from several 
measurements 
Trend analysis  Analysis of a trend from a number of individual 

measurements available for selection 

 
Fig. 1: 4.4 Evaluation - Menu Commands  
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5.4.1 Table  
 

Tabular presentation of the sieving results, showing a list of the grain size classes 
and the fractions found in them. The menu can be accessed more quickly by 
pressing the F5 function key. 

5.4.2 Graph  
 

Presentation of the sieving results in the form of a graph. The abscissa displays the 
particle size and the ordinate shows whichever characteristic has been selected 
(Q3 and p3 are standard). The menu can be accessed more quickly by actuating 
the F6 function key. 

5.4.3 Characteristics Settings  
 

Tabular presentation of the characteristics. The menu can be accessed more 
quickly by clicking on the F7 function key. 

5.4.4 Mean Value  
 

This command serves to form the mean value of several sievings which were 
saved under one sieve task. 

5.4.5 Trend Analysis  
 

To monitor alterations in the particle size distribution, several sievings can be 
evaluated in a trend analysis. 

5.5 Options - Menu Commands  
 

The Options menu contains the following commands: 
Alter the grain size limit Definition of the largest and the smallest grain size  
Sieving parameters   Setting sieving parameters 
Edit sieve stack file  Creating and saving sieve stack files 
Sieve stock     Creating and saving the sieve stock 
Edit reference file   Creating and saving reference files 

 
Fig.1: Options - Menu Commands  

 

5.5.1 Change Grain Size Limit  
 

This menu item serves to change the grain size limit (lower and upper limits of 
particle size) in sievings already executed. 
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Fig. 2: Change grain size limit  
Alterations made relate to the sieving in the memory (i.e. the sieving that was last 
conducted or loaded by means of Open – File). This dialogue is exited by clicking 
on OK and any evaluation window that is opened is updated. 
To change the rdf file permanently, it must be saved again then with the “file save 
as” command. 
The inputs are not entered into the sieving task and the sieve stack file.  

 

5.5.2 Sieving parameters  
 

This command serves to set the sieving parameters. In particular the connected 
hardware (balance) is configured here. 
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Fig. 2: Sieving Parameters Window  
For documentation purposes in conformance to BS ISO 9276 the appropriate 
entries must be made in the  
• Sampling 
• Sample preparation 
• Sieving method 
• Sieve size 
• Sieving according to standard 
• Sieving aids 
fields.  
To make inputting easier, preset texts can be used in most fields. The selected 
entries appear in the sieve report and in the characteristics window when “Edit”- 
“Display of Measuring Conditions“ are selected. 
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Sieving machine: for documentation purposes the name of the sieving machine 
being used must be entered in the “designation” window in the sieve report. 

5.5.3 Balance Setting 

Manual input: The weights are entered by hand at the time of the sieving (sieving 
item menu). 
Using the balance: The weight is inputted automatically by pressing the key on 
the Mettler balance. 
Other balance: Another balance is used, which can output the weight through the 
serial interface. The connection can be freely configured by means of the settings. 
The connection must be configured in conformance to the specifications given by 
the manufacturer or in accordance with the settings made on the balance. 
The connection to the balance can be configured in the windows underneath. 
(See figure “Sieving Parameters Window” above) 
Interface: Input of the number of the serial interface (COM no.) through which the 
connection was made to the balance. The COM interface must be configured at the 
balance in accordance with the works standard for the respective balance (data 
bits, baud rate, stop bits, parity). 
TimeOut [s]: Time-out duration during the establishment of communication. If the 
Mettler balance is activated, the connection to the balance is checked when the 
sieving menu item is called up. The balance must respond within the set time-out 
duration. The time must be selected so that the balance will react within this time to 
a print command sent from a PC even if the data output is set after standstill. 
The length of the signal can be set. If the “fixed length” is selected, the data length 
of the signal must be specified. If the “end character” is selected, the ASCII 
character must be defined with which the balance communicates the end of the 
data signal. 
The preset communication parameters for balances from the Mettler and Sartorius 
makes: for Mettler and Sartorius balances different modes of communication can 
be selected from a list. Please check the operating instructions of your balance to 
see if it supports one of the pre-set modes of communication and then select it. 
Use the “test” key to test communication with the balance.  

 

5.5.4 Edit Sieve Stack File  
 

This menu item serves to define sieve stack files. When it is called up, the “Edit 
sieve stack file” dialogue box appears. 

 
Fig. 3: Edit Sieve Stack File  
NOTICE: 
If the sieve stacks are to be used for the next sieving, they must be saved in a file. 
This file must then be entered as a sieve stack file into the sieve task and saved. 
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If “µm” was selected, all values are displayed as µm and all inputs are interpreted 
as µm. Otherwise all sizes are specified in mm. 
The following possibilities exist for quickly allocating the sieve sizes: 
Reading the sieve stack file: 
  Reading an existing sieve stack file *.gkl.  
Creating: 

The limits of the sieving series R5, R10, R20/3, R40, R40/3, ASTM Mesh, 
Tyler Mesh are set as desired between Xmin and Xmax.  

 
Fig. 4: Create Sieve Stack  
In the free text window on the right side a sieve stack file can be edited freely. The 
individual mesh aperture sizes, separated by a space, are entered for this purpose.  
Inputs can be sequenced at will. The “update” key sorts the mesh aperture sizes in 
order of size. A maximum of 16 sieve sizes are possible. 
If the sieving series was derived from ASTM Mesh or Tyler Mesh, it is only possible 
to delete individual classes or to reintegrate previously deleted ASTM or Tyler 
Mesh classes. 
The following are optional entries: 
Upper limit: Upper grain size limit of sieving 
Lower limit: Lower grain size limit of sieving 
Both variables are entered into the graphical evaluation only. 
Sieve stack properties: 
The properties of the individual sieves can be viewed in this menu item. 
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Fig.3: Sieve Stack Properties  
Add from sieve stock: 
If “Options/Sieve Stock” sieves are filed in the menu item, they can be added to the 
sieve stack. 
To save the sieve stack file, the “save” button must be actuated and a sieve stack 
file name must be entered. 

 

5.5.5 Sieve Stock  
 

The sieve stock menu permits the production and administration of a fixed stock of 
sieves. 

 
Fig. 4: Sieve stock window  
In addition to the sieve’s mesh aperture, the sieve stock contains the sieve’s tare 
weight and a clear identification (ideally the serial number).  
This makes subsequent sieving easy because it removes the necessity of weighing 
the empty sieve beforehand. It is essential for this that the sieve be cleaned 
thoroughly so that the exact tare weight is maintained.  
Once the tare weight is inputted and – if known - the mesh aperture sizes in the 
warp and weft directions, the sieve can be integrated into the sieve stock by 
clicking on the Add button. A name for the sieve and its nominal mesh aperture 
size are queried.   
The Remove key deletes the highlighted sieve from the sieve stock. 
The entire stock can be viewed in the “Sieve stock“ list and exported here as 
ASCII: 
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Fig. 5: Sieve Stock List  

 

5.5.6 Edit Reference File  
 

This menu item serves to create and save a reference file. A reference curve is a 
cumulative distribution of Q3 (x). It can be used as a comparison curve in the 
diagram. 
The reference curve can be entered by means of the known distribution sums (Q3), 
residue (1Q3), fractions (p3) or masses. For this purpose the appropriate input 
method must be selected before beginning the input. 
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Fig.1: Input of the Reference Distribution  
The reference curve is inputted in two columns: 
1st column:  
X values (diameter) in ascending order with the input of Q3 and 1-Q3 and in 
descending order with the input of fraction or mass. 
2nd column:  
Q3 (x), 1-Q3, fraction and/or masses. When the p3 fractions are entered, the sum 
must be 1 and/or 100%.  
When the dialogue box is opened, the editing field is still empty. Then the particle 
diameter x and the cumulative distribution of Q3 (x) can be entered in pairs, 
separated by a space. x must be entered in ascending order. After editing, the 
“Update” button should be actuated. The inputted text is then checked and 
reformatted. 
The measurement units can be selected with the appropriate check boxes. If there 
are values in the editing field already, they will be converted and updated. 
The “Paste” button allows data to be inputted in text format from the clipboard. This 
overwrites the existing data in the Edit box. The data in the clipboard must consist 
of two columns, containing x and Q3 (x), whereby x is rising. x can be specified in 
mm or in µm. Q3 (x) can be entered in % or without a measuring unit.  
The “Load” button allows data to be loaded from a text file. The text data can be a 
reference file or a file in Endecotts file format (*.ccg). It is also possible to load a 
text file created with a text editor. This file must consist of two columns, containing 
x and Q3 (x), whereby x is rising. x can be specified in mm or in µm.  
Q3 (x) can be specified in % or without a measurement unit. When loading from a 
file, the existing data in the Edit box will be overwritten also. 
Both when pasting from the clipboard and when reading text files, tabulators or 
spaces are interpreted as separators. Commas or points are interpreted as a 
divider in a decimal number. 

5.6 Extras – Menu Commands  
 

The Extras menu contains the following commands: 

Date Switches automatic date acceptance on or off 

Enter task mode All menu items are active 

Activate the measuring 
mode 

Only measuring and evaluating are possible 

Screen font Setting of font and font size for the evaluation 
windows 

Printer font like screen font Automatic adjustment of the printer font to the 
selected screen font 

Set-up printer font Setting of font and font size for the print report 

Set-up report Set-up of print report, integration of a customised 
logo 
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Fig. 2: Menu Commands Extras  

 

5.6.1 Date  
 

This command is used to switch automatic date acceptance on and off during 
measurements. If “Date” is activated (ticked), the date and time of sieving is 
transferred automatically and shown in the measurement log as well as in the 
characteristics window.  When the date acceptance is deactivated, the appropriate 
fields remain free. 

5.6.2 Activation of Task Mode  
 

The task mode is always activated after installing the software. This menu item is 
therefore inactive. In task mode all menus are enabled and all parameters of 
relevance to sieving can be edited. 
In the active measuring mode the task mode can be activated only when a valid 
password has been inputted. The standard password is “password”. 

5.6.3 Activation of the Measuring Mode  
 

To prevent parameters being altered unintentionally, the software can be put into 
measuring mode. In this mode the user can only conduct measurements and make 
evaluations. 
If the “Activate measuring mode” menu item is selected, the user is asked to input 
and confirm a password for returning to the task mode. 
Note: Please be careful with passwords to prevent abuse and unwanted software 
disablements. 

 

5.6.4 Screen Font  
 

This menu item is used for selecting the fonts for the evaluation windows. The 
selected set-up is saved and is also available for calling up the following programs. 



 Main Window - Description of the Menu Items 

33 

 
Fig. 1: Choice of font for the evaluation window  
To avoid text overlapping, it is advisable not to choose too large a font in the 
display. The standard font is Arial, regular font style and size 8. 

 

5.6.5 Printer font like screen font  
 

By setting this option, the printer font is adjusted automatically to the screen font. 
The “set printer font” menu item cannot be selected then. 

 

5.6.6 Set Printer Font  
 

This menu item is used for choosing the font for the print report. The selected set-
up is saved and is also available for calling up the following programs. 

 

5.6.7 Set up report  
 

This menu item is used to set up the print report. A customised bit-map file 
(company logo) can be integrated into the report. 
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Fig. 5: Set-up of print report  
The logo to be integrated must be available as a 256-colour bitmap and be filed in 
the program directory (C:\Programs\SieveWare). It is inserted into the top left of the 
print report. The exact position and size are adjusted by means of the following 
parameters. 
Start x  X position in the report of the upper left corner of the logo [mm] 
Start y  Y position of the upper left corner of the logo [mm] 
Size y  size of the bit-map in the report [mm] (y direction, the size is 

changed proportionally in the x direction)  

5.6.8 Communication log  
 

This menu item is used to set up a log of communication between the software and 
the balance to support the communication facility. To produce the respective 
report, a tick is made before the sieving at the respective device.  
The report is filed in the …. folder. 

 
Fig. 1: Set-up of Communication Log 

5.7 Help - Menu Commands  
 

The Help menu contains the following commands to assist you in this application: 
Help     Display of the SieveWare help index  
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Help topics   Displays the directory of the themes for  
which help is available  

Information on SieveWare  Shows the number of this application version 

 
Fig. 1: Menu Commands Help  

6 Table Window - Description of the Menu Items  
 

The table window serves to show the sieving results in tabular form. The p3 
(fraction), Q3 (distribution), 1-Q3 (residue), q3 (density), Δm (mass of the sieving 
residue) and ΣΔm (gross mass residue) variables can be shown. 

 
Fig. 1: Presentation of the sieving results in tabular form  
 
The following table presents a summary of the toolbar buttons in the table window. 
If the button corresponds to a menu item, the menu item is specified beside it. 
Otherwise the function of the button is described in brief. 

 
Fig. 6: no. of the button  
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No. of the 
button 

Menu item / function 

1 “Edit” - “Copy” 

2 “File” - “Print.” 

3 Display of grain size class in µm 
4 Display of grain size class in mm 
5 Display of results from 0-1 

6 Display of results in percentages 

7 Presentation of the p3 fractions in columns 
8 Representation of the Q3 cumulative distribution in columns 
9 Representation of the 1-Q3 cumulative residue in columns 

10 Representation of the q3 density function in columns 
11 Representation of the mass fractions in columns 
12 Presentation of the cumulated mass in columns  

13 Help 
 

6.1 File - Menu Commands  
6.1.1 Print Table  
 

The measurement table displayed on the screen is printed out. In the printed image 
the file name of the measurement is put in front of this table. 
The font and font size of the printed table is decided by the set-up in the “Extras” – 
“Screen font” menu item. 

 

6.1.2 Exit  
 

The table window is closed. If any of the alterations made to the table settings are 
to be effective in subsequent measurements too, the sieving task must be saved 
again now (see “Sieve analysis” - “Save sieving task”). 

6.2 Edit - Menu Commands  
 

The Edit menu contains the following commands: 
Copy   Copies the displayed table window into the clipboard 
Copy (ASCII) Copies the table contents as ASCII text into the clipboard 

  
Fig. 1: Menu commands Edit  

6.2.1 Copy  
 

The table window presented on the screen is copied in Metafile format into the 
clipboard. The file name of the measurement is pasted to identify the measurement 
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or when mean values are being produced, the table is identified as a table of mean 
values.  

6.2.2 Copy (ASCII)  
 

The data in the table is copied as ASCII text into the clipboard. 

6.3 View - Menu Commands  
 

The View menu contains the following commands: 
Settings Opens the selection window for the properties that are to be 

shown. 
Units    Allows the units to be selected. 

  
Fig. 7: Menu Commands View  

6.3.1 Set-ups  
 

This menu item summarises the essential setting possibilities in the table window. 

    
Fig.1: Setting possibilities in the table window   
You have the option of making the settings with the aid of this dialogue box or (with 
the exception of the serial numbers, ASTM Mesh, Tyler Mesh and reverse settings) 
with keys 3-12 in the toolbar. 
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The serial numbers setting allows tracing to a sieve when the serial number is 
known. This option is usable only if sieves are used from the sieve stock which are 
filed there with a serial number. 
The ASTM Mesh and Tyler Mesh settings add information to the table on the mesh 
number in accordance with the ASTM or Tyler systems. 
The reverse setting inverts the table so that the results are not in ascending mesh 
aperture size but displayed in a descending mesh aperture size instead. 

6.3.2 Measuring Units  
 

This menu item summarises the settings for the measuring units in the table 
window. There is a choice between having the grain size displayed in µm or mm. 
The totals and fractions are presented in a choice of normalisation to 1 or in %. 

  
Fig.1: Measuring Unit Settings in the Table Window  

7 Graph - Description of the Menu Items  
 

The graph is the graphical representation of grain size distributions measured with 
SieveWare or formed as mean values of several measurements. 

 
Fig.1: Graph of the Grain Size Distributions  
The file name of the presented measurement is given in the header. If mean 
measurements are presented, this is indicated by the “mean value” marking.  
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There are a maximum of two ways of presenting the measurement results in a 
graph. The following can be represented: p3 (density), Q3 (distribution), 1-Q3 
(residue), q3 (density). For this purpose two y axes can be configured. 
When the diagram is called up, the x axis is set to register the current measuring 
range of the sieving. However, it is also possible to choose fixed limits, whereby 
the graph is presented of a range between the inputted variables.  
The x display area can be reduced by right dragging over the area of interest 
(zoom function). It must be noted here that the area marked in this way is extended 
to the degree that the size classes it encompasses can be displayed completely. 
The display range can be increased again by repeatedly clicking on key 4 “Zoom” 
in the toolbar. 
The following table shows a summary of the buttons in the toolbar of the graph 
window. They are numbered from left to right. If the button corresponds to a menu 
item, it refers to it. Otherwise, the function of the button is described in brief. 

 
Fig. 2: Buttons in the toolbar in the graph window  

No. of the 
button 

Menu item or function 

1 "File"-"Comparison File" 

2 "Edit"-"Copy" 

3 "File"-"Print" 

4 Increase the x axis display (in accordance with measuring range) 

5 Representation of the y axis linear, x axis linear  

6 Representation of the y axis linear, x axis logarithmic 

7 Representation of the y axis logarithmic, x axis logarithmic 

8 Representation of the cumulative distribution in the RRSB grid 

9 Add vertical grid lines 

10 Delete vertical grid lines. 

11 Add horizontal grid lines 

12 Delete horizontal grid lines 

13 Mapping onto left y axis = bar chart p3 

14 Mapping onto left y axis = cumulative distribution curve Q3 

15 Mapping onto left y axis = cumulative residue curve 1-Q3 

16 Mapping onto left y axis = density curve q3 

Note: The right y axis continues to be used for mapping the Q3 cumulative 
distribution. 
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7.1 File - Menu Commands  
 

File – Menu Commands  
The file menu contains the following commands: 
Read comparison file  Allows several sievings to be compared in a graph 
Print graph     The displayed graph is printed 
Exit       The graph window closes 

 
Fig. 1: Menu Commands File  

7.1.1 Read Comparison File  
 

One or more comparison curves (maximum of 9) showing the most recently 
executed or loaded sievings  can be loaded (if necessary with the help of the Shift 
or Ctrl keys).  
These are displayed as well in the presentation afterwards until the graph window 
is closed or until deleted by clicking with the right mouse button on the file names 
in the legend. 
The sieving tasks in the comparison files can be very different from the original file 
and from each other. Each selected raw data file is evaluated with the current 
status of parameters for the sieving task under which it was measured (the name 
of the sieving task is contained in the *.rdf file). 

7.1.2 Print Graph  
 

The measurement graph produced on the screen is printed out. The file name of 
the measurement is placed in front of this in the printed image. 
The font and font size for the graph designation is decided by the setting in the 
“Extras” menu item.  

 

7.1.3 Exit  
 

The graph window is closed. Whenever the graph window is called up again, the 
comparison files must be reloaded. If changes made to the graph setting are to be 
effective in the representation of subsequent measurements also, the sieving task 
must be saved again (see “Sieve analysis” - save sieving task”). 

7.2 Edit - Menu Commands  
 

Edit – Menu Commands The Edit menu contains the following command: 
Copy    Copies the graph into the clipboard 

  
Fig. 1: Edit Menu  
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7.2.1 Copy  
 

The graph presented on the screen is copied in Metafile format into the clipboard. 
The file name of the measurement is pasted to identify the measurement. In the 
case of mean values the table is marked as a mean value table. 

7.3 View - Menu Commands  
 

The view menu contains the following commands: 
Settings Characteristics selection (displayed)  
Units   Unit selection window 

    
Abb. 8: Menu View  

7.3.1 Settings  
 

Essential graph settings may be made here. In particular it is possible to configure 
the right y axis (= 2nd y axis) and map it to curve and bar types. 
The axes in the graph can be configured as linear or logarithmic. The choice of the 
“RRSB” for the first y axis blocks the second y axis. It is not possible to combine a 
linear x axis and a logarithmic y axis. In addition a fixed range in mm can be 
specified for the x axis also. 
Reference curves *.ref can appear as cumulative distribution or residue curves 
under the “upper limit” and “lower limit” designations. These settings are effective if 
Q3 and 1-Q3 are presented for the y axis. 
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Fig. 1: Graph settings  

7.3.2 Measuring Units  
 

Measuring Units 
This menu item summarises the settings for the measuring units in the graph 
window. You can choose between having the grain size presented in µm or mm. 
The totals and fractions are presented optionally normalised to 1 or in %. 
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Fig. 1: Measuring Units Settings for the Graph Window  

7.4 Extras – Menu Commands  
 

Extras – Menu Commands 
The Extras menu contains the following commands: 
Colours    Selection of the colours for the individual curves  
Type of curves  Selection of the type of curve 
Type of bars  Selection of the type of bar for the p3 presentation 
Grid     Definition of the grid presentation 
Legend   Selection of the legend properties 

  
Fig. 9: Commands in the Extras Menu  

7.4.1 Colours  
 

The “Graph colour settings” dialogue allows colours to be assigned at will to each 
curve. 
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Fig. 1: Diagram Colour Settings  
An individual colour can be chosen for each axis in the curve or bar presentation 
by left-clicking on the respective colour field. The reference curves can be 
assigned their own colours too. A quick change is possible then through the 
Windows colour selection dialogue.  
The “Standard” key allows a quick resetting of the curve colours at any time to the 
program’s standard colours. 

7.4.2 Curve Colours  
 

Whether or not the curves that are presented should have lines and/or symbols 
(marking sieve fractions) is controlled here. At least one option must be selected. 

 
 

7.4.3 Type of Bar  
 

The “Select Type of Bar” dialogue allows the configuration of the bar representing 
the fraction shares. When the “frame” type of bar is chosen, the bar is shown in the 
colour of the selected curve colour and otherwise as the bar structure in the 
corresponding curve colour surrounded by a black frame.  

 
Fig. 1: Type of Bar Setting  

7.4.4 Grid  
 

The grids in the graph can be configured with respect to type of line and colour. 
The grid colour can be changed quickly by clicking on Colour Selection in the 
Windows colour selection dialogue.  
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Fig.1: Type of Grid Setting  

7.4.5 Legend  
 

The legend can be configured here. This appears in the diagram only when the 
“Description of Curves” was activated. 

 
Fig. 1: Legend configuration  
The selection “with two lines” is effective only if the right y axis is activated in the 
graph.  

8 Characteristics Window - Description of the Menu Options  
 

The characteristics window is used to display the characteristics in the current 
sieving. 
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Fig. 1: Characteristics Window  

8.1 File - Menu Commands  
 

The menu file contains the following commands: 
Print characteristics  Prints the currently displayed characteristics table 
Exit     Closes the characteristics window 

 
Fig.1: Characteristics - Menu File  

8.1.1 Print Characteristics 
 

The characteristics table produced on the screen is printed. In the print image the 
name of the sieving file is placed in front of the table. 
The font and font size of the printed characteristics table is determined by the 
settings in the “Extras” “Screen Font” menu item. 
If any alterations made to the selection of characteristics are to be effective for 
subsequent sievings as well when the characteristics window is closed, the sieving 
task must be saved again now (see “Sieve Analysis” - “Save Sieving Task”). 

 

8.1.2 Exit  
 

The characteristics window is closed.  

8.2 Edit - Menu Commands  
 

Edit – Menu Commands 
The Edit menu contains the following commands: 
Copy    Copies the displayed table window  

into the clipboard 
Copy (ASCII)  Copies table contents as ASCII  

text into the clipboard 
Show characteristics     Displays characteristics 
Show measurement conditions Displays the measurement conditions on 

which the sieving is based 

   
Fig. 1: Edit Menu  
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8.2.1 Copy  
 

The characteristics window shown on the screen is copied in Metafile format into 
the clipboard. To identify the sieving, the file name of the sieving is inserted. The 
mean values are marked as such.  

8.2.2 Copy (ASCII)  
 

The individual characteristics are copied in ASCII format into the clipboard. A line 
consists of the description of the characteristics and the value of the characteristic. 
The elements in a line are separated by tabulators. As a heading the descriptions 
“characteristic” and “value are placed in front of the table. Numerical values are 
shown with a “comma”.  

8.2.3 Show Characteristics  
 

Once this menu item is called up, all data noted in the report header for a sieving 
are shown in the characteristics window. 
- Name of the sieving task 
-   The characteristic and the associated value. The characteristics that are to 

be shown can be selected in the “View Characteristics“ menu item. 
- Date and time of the sieving 

8.2.4 Show Measurement Conditions  
 

Once this menu item is called up, all data marked in the report title for a sieving are 
shown in the Characteristics window. 

8.3 View - Menu Commands  
 

View – Menu Commands the View menu contains the following commands: 
Settings Opens the selection window for the characteristics to be 

displayed. 
Measuring Units  Enables the selection of units 

  
Fig. 1: Menu View  

8.3.1 Settings  
 

This is where the individual characteristics are selected and set. 
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Fig. 1: Selection and Setting of the Individual Characteristics 
The following can be selected: 
-  3 adjustable x (Q3) - values, the % value is freely selectable 
-  Span value = (x (Q3) - x (Q1))/x (Q2) 
-  Non-uniformity = x (60) /x (10) 
-  3 adjustable Q3 (x) or alternatively 3 adjustable 1-Q3 (x) values 

8.3.2 Measuring Units  
 

The menu item summarises the settings of the measuring units in the 
characteristics window. You can choose between presenting the grain size in µm 
or mm. The totals and fractions are shown normalised to 1 or in % as desired. 

  
Fig. 10: Measurement Units in the Characteristics Window  

9 Mean - Description of the Menu Items  
 

This command serves to form the mean value of several sievings saved under one 
sieving task. A precondition for the formation of the mean is the use of the same 
sieve stacks in all the sievings used as the basis for forming the mean. 
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Fig. 11: Command for the Formation of the Mean  
A mean can be formed from up to 50 sievings. The files which can be used as the 
basis to form a mean must be highlighted in the “Select Files” box (if necessary 
with the aid of the Shift or Ctrl keys).  
Providing there is no error in the selection of files, the averaging result will be 
displayed as soon as “Open” is clicked. 
The averaging result is then available as a current sieving in RAM and can be 
saved by means of “Save file” (rdf file) or file export (xld, xle and/or ccg file). 

10 Trend Analysis Window - Description of the Menu Items  
 

The trend analysis permits the representation of the temporal course of selected 
characteristics in a measuring series. The x50 characteristic is shown as standard. 

 
Fig.1: Representation of the Time Course of Selected Characteristics  
A series of measurements for conducting the trend analysis is composed of a 
number of files created using the same sieving task and filed in the same directory. 

When the trend analysis is called up, the user is asked to select the series of 
measurements.  



Trend Analysis Window - Description of the Menu Items  

50 

 
Fig.2  Selection of the Series of Measurements  
It is sufficient here to click on a raw data file that belongs to a series of 
measurements. Once the selection has been confirmed, the measuring series that 
belongs to this file is prompted in a dialogue box.  

 
Fig. 3: Selection of the series of measurements  
The selection is determined by the setting decided in the corresponding sieving 
task.  
In the dialogue the selection of files can be specified further. 
All files:  
All files are analysed without taking the file name into consideration. They are 
presented on a time axis. 
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File numbers:  
All files with the selected file name (e.g. “M”) are displayed, whereby the range of 
numbers is adjustable. They are represented on a “file no.” axis. 
Time range:  
All files with the selected file name (e.g. “M”) are shown, whereby a restriction in 
time range is possible. They are presented on a time axis. 
If the setting is changed, the updated file and time range can be shown when the 
“Update” button is pressed. 
Once the file selection is confirmed by clicking on “OK”, the adjusted characteristics 
are shown in their time course. The x axis is determined by means of the selected 
file numbers or time range.  

10.1 File - Menu Commands  
 

The file menu contains the following commands: 
Print trend analysis   Prints the displayed graph 
Exit    Closes the trend analysis window 

   
Fig. 1: Menu File Trend Analysis  

10.1.1 Print Trend Analysis  
 

The adjusted trend graph is printed. As identification the trend window header is 
placed in front of the printed graph.  

 

10.1.2 Exit  
 

The trend analysis is ended. If any changes made in the trend analysis setting are 
to be effective in subsequent analyses also, the sieving task must be saved again 
(see “Sieve analysis” - “Save sieving task”). 

10.2 Edit - Menu Commands  
 

Edit Menu Commands 
The Edit Menu contains the following command: 
Copy    Copies the displayed graph into the clipboard 

   
Fig. 2: The displayed graph is copied into the clipboard  

10.2.1 Copy  
 

The adjusted trend graph is copied into the clipboard. The headline of the trend 
window is inserted into the graph as identification. 
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10.3 View - Menu Commands  
 

The View menu contains the following commands: 
Characteristics Setup of characteristics and graph parameters 
Units    Selection of the measuring units for the graph 

 
Fig. 3: View Menu – Characteristics  

10.3.1 Settings  
 

This menu item exists only in the task mode. Here the quantity can be set and the 
characteristics to be shown over the course of time can be selected. 

  
Fig. 1: Quantity Setting and Selection of the Characteristics to be Represented in 
their Time Course  
X axis: 
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The x axis is configured in the graph as a time axis. Presentation is possible in 
minutes, hours and days. These variables are set in “View” “Units” 
File no. 
The x axis is configured in accordance with the number of files to be analysed. 
Y axis: 
One to four characteristics can be shown in one or two coordinate systems. Up to 
two characteristics can be shown in each coordinate system. Each characteristic 
can be configured with the aid of the “Edit” button. 

 
The characteristics which can be represented are  
x (Q3)   Only one Q3 measurement need to be entered for this. 
Q3 (x)   One x value must be entered here. 
1-Q3 (x)    One x value must be entered here 
p3 (x1, x2)   Two x values x1, x2 must be entered for this. 
Span value  Three Q3 values have to be entered here. 
Non-uniformity It is not possible to edit this parameter. 
 
If required, fixed limits can be entered for the y axis (“upper limit” and “lower 
limit”).Otherwise the limits are set automatically according to the range of 
fluctuations in the measurements. 
With limit lines: 
In each trend graph limit lines can be defined as required for the left y axis, which 
make it clear to the user when measurements exceed certain limits or fall short of 
them. The y-values for the limit lines can be entered then as upper and lower limits. 
The first coordinate system is always active. If the 2nd coordinate system option is 
selected, 2 graphs are shown underneath each other in the trend graph window. 
The parameters for the second coordinate system can be selected in the same 
way as for the first coordinate system. 

10.3.2 Measuring Units  
 

The measurement units to represent the trend analysis can be set here. 
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Fig. 12: Units for presenting the trend analysis  
The selection of days/hours/minutes is effective only if the x axis was configured as 
“time”. 

10.4 Extras – Menu Commands  
 

The Extras menu contains the following command: 
Curve colours  Settings for the colours to be used for displaying the curves 

   
Fig.2: Colour Settings for the Curves 

10.4.1 Curve Colours  
 

The colours for the curves in the trend analysis can be set here. 
The curve colours can be changed by left-clicking on the colour shown. The colour 
can then be changed quickly with the aid of the Windows colour selection dialogue. 
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Fig. 1: Colours For Curves in Trend Analysis  



Appendices and Examples  

56 

 
  

11 Appendices and Examples  
11.1 Print Report  
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